
 

 

 

CENELEC Standard Template — Quick Start Guide 

 

 

 

  

 

 

 

 

 

 



CENELEC Standard Template — Quick Start Guide 

2 
 

Contents Page 

Introduction .................................................................................................................................................................... 3 

1 Getting Started ................................................................................................................................................ 4 

2 Using the template ........................................................................................................................................ 5 

3 Front Matter ...................................................................................................................................................... 9 

4 Main Body – Obligatory Clauses ........................................................................................................... 10 

5 Main Body – Generic Clauses ................................................................................................................ 12 

6 Additional components of the text ....................................................................................................... 13 

7 Finishing touches ........................................................................................................................................ 19 

Annex A (informative)  Useful Information Sources ................................................................................... 24 

A.1 General ............................................................................................................................................................. 24 

A.2 Webinars .......................................................................................................................................................... 24 

A.3 Internal Regulations Part 3 ...................................................................................................................... 24 

A.4 Still stuck? ...................................................................................................................................................... 24 

Annex B (Informative)  Useful Keyboard Shortcuts .................................................................................... 25 

 



CENELEC Standard Template — Quick Start Guide 

3 

 

Introduction 

Welcome to the CENELEC Standard Template Quick Start Guide!  

This document will provide a comprehensive overview of the CENELEC Standard Template, and how to use 
the Template to draft quickly and efficiently, whether you're starting new work, or revising an existing 
standard. This document is supplementary to the content found on the CENELEC BOSS website.  

Happy drafting! 
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1 Getting Started 

You have downloaded the CENELEC Standard Template from the CENELEC BOSS – now what?  

The Standard Template contains all the applicable styles needed to provide an XML file. At present, 
CENELEC Editors have the obligation to provide an XML file as part of the standards deliverable package for 
100 % of applicable deliverables. This is why the Standard Template is an indispensable tool for all involved!  

The template itself is easy to use. Throughout the template, you will see there are portions of red and blue 
text. The red text is text that should be edited accordingly in each document (e.g. in Clause 2). The blue text is 
a note to the drafter and shall therefore be deleted prior to submission. 

The template is a flat Word document, so editing it according to your needs is easy, provided you have access 
to Word. Simply open the template as normal, and you're ready to start drafting! 

If you are drafting a new standard that does not have a previous edition, you can simply type straight into the 
template. If an existing standard is being revised, then the text of that standard can be copy-pasted into the 
template.  

All obligatory components are found in the Standard Template, clearly defined for your convenience. In 
addition, the updated rules from the Internal Regulations Part 3 are applied, too, but further information on 
those can be found on the CENELEC BOSS.  
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2 Using the template 

2.1 General 

The Standard Template is a flat Word document designed to be drafted straight into.  

The structure given in the template is a guide. After Clauses 1, 2 and 3, your standard will likely follow a 
different structure. This means you'll need to apply a number of different styles, all of which are found within 
the template.  

It is advised that you draft with the paragraph markers  visible (although this is not obligatory).  

For CENELEC deliverables, the font is Arial, and the size for plain body text is 10 pt.  

2.2 Styling Palette 

The styling palette is handy to have open during the drafting process. The palette gives you access to every 
style found in the document. Each style is clearly named so you can choose which style you need without too 
much hassle.  

To open the styling palette, select the 'Home' tab from the ribbon across the top of Word, and go to the 'Styles' 
section. Click the small arrow highlighted in Figure 1.  

 

Figure 1  Opening the Styling Palette 

The styling palette is shown in Figure 2.  
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Figure 2  The Styling Palette 

The palette is a separate window which you can move around, resize as desired, and fully scrollable. 

2.3 How to see applied styles 

When applying the styles, it's always best to use the draft view, rather than the default print view. The draft 
view allows you to see each style in a left-hand-side pane, allowing you to apply the styles quickly and easily.  

The draft view is found under the 'View' tab across the top ribbon, in the first section (see Figure 3). 
Alternatively, the keyboard shortcut 'Ctrl+Alt+n' can be used. For a comprehensive list of useful keyboard 
shortcuts, see Annex B.  

 

Figure 3  Finding the Draft View 
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When you're in the draft view, if you do not see a style pane on the left-hand-side, you need to adjust your 
settings. To do this, open up the settings in Word using 'File' and then 'Options'. This will open a pop-up 
window shown in Figure 4. Under the 'Advanced' tab, scroll down to 'Display'.  

 

Figure 4  Setting the Styling Pane 

The row 'Style area pane width in Draft and Outline Views' needs to be set at around 3 cm (1 inch). The pane 
can then be dragged to the right to increase the size, if needed.  

2.4 Applying styles throughout the document  

Applying styles is straightforward – a simple 'point and click'. Once the palette is open, you can simply 
highlight or click on the text you wish to style and click the chosen style in the palette.  

If you want to apply a single style to a number of different paragraphs through the text, but these paragraphs 
are in different clauses, you can use the format painter tool, too. If you don't want to click, or you prefer 
keyboard shortcuts, styles can be copy-pasted.  

To copy a style, highlight the text and press 'Ctrl+Alt+C'. To paste, highlight the desired text and press 
'Ctrl+Alt+V'.  

If you're applying styles in the draft view, you do not need to highlight the text to copy and paste styles. You 
can simply click the text, copy the style, click the text to be styled, and then paste!  
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2.5 Inserting Symbols  

If you need to add a table or a figure to your deliverable, XML requires that you use an 'Em' dash in the title. 
This is simply a long dash and is found under the 'symbols' function in Word. Go to the 'Insert' tab across the 
top ribbon, and select 'Symbol' and then 'More symbols' (see Figure 5).  

When you use each symbol, it'll appear in the 'Recently used symbols' row at the bottom of the window in 
Figure 5. You can also set up a keyboard shortcut key if you regularly have a lot of tables and figures.  

 

Figure 5  Em Dash 

Inserting symbols this way is a better alternative to using the equation builder, too. See Clause 6.3 for 
additional guidance on formulae.  
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3 Front Matter 

3.1 General 

The front matter of your deliverable is the European Foreword and the Introduction. Each of these elements 
have their own drafting rules, and the styling behind them is a little different.  

3.2 European foreword 

3.2.1 Template information 

The European foreword is an obligatory element. Its placement in the Standard Template is fixed: after the 
table of contents but before the Introduction/clause 1.  

The Standard Template contains the correct template text for the foreword. The black text shall remain, as this 
is official template text. The red text is editable. Certain components in the foreword can be deleted, however.   

1. This document (prEN XXXX:XXXX) has been prepared by CLC/TC/SC/SR XXX “Title”. 

2. This document is currently submitted to the CENELEC Enquiry/Primary Questionaire/Vote on TS/TR. 

3. The following dates are proposed:  

• latest date by which the existence of this 
document has to be announced at national 
level 

(doa) dav + 6 months 

• latest date by which this document has to be 
implemented at national level by publication of 
an identical national standard or by 
endorsement 

(dop) dav + 12 months 

• latest date by which the national standards 
conflicting with this document have to be 
withdrawn 

(dow) dav + 36 months 
(to be confirmed or 
modified when voting) 

 

4. This document will supersede EN XXXX:XXXX and all of its amendments and corrigenda (if any). 

5. In comparison with the previous edition, the following technical modifications have been made: 

6. This document has been prepared under a mandate given to CEN by the European Commission and 
the European Free Trade Association, and supports essential requirements of EU 
Directive(s) / Regulations. 

7. For relationship with EU Directive(s) / Regulations, see informative Annex ZZA, ZZB, ZZC or ZZD, 
which is an integral part of this document. 

Point 1 is obligatory text. The 'X' elements in red, i.e. the document reference, TC number, Title and 
Secretariat, are editable.  
NOTE In some cases, it is possible you do not have a reference yet. If this is the case, leave the text as it is, and the 
CCMC Editor will add the correct reference.  

Point 2 describes the stage the text is at. This is the official template text. If you are drafting an EN, keep the 
first option. For a Technical Specification or Technical Report, choose the second or third option.  

Point 3 is the implementation dates table. Nothing needs to be filled out for this section. 

Point 4 covers the superseding information. If the text is a first edition, this shall be deleted.  

Point 5 is only applicable if the text is a revision. If so, please add a short list of only the main changes which 
have been made to the text in comparison with the previous edition.  

Points 6 and 7 are only applicable to deliverables which are harmonized. If your deliverable is not 
harmonized, this text shall be deleted.  
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In the case of revisions, where the publication text of the previous edition has been used, anything outside the 
scope of this clause shall be deleted.  

3.2.2 Styling the European foreword 

The European foreword has its own special styles which are only used for the foreword.  

• Title: 'Foreword Title' 

• Text: 'Foreword Text' 

• Lists: 'List Continue' or 'List Bullet' or 'List Number' 
NOTE Using 'Body text' or adapting the Heading 1 style in the foreword will generate XML errors.  

3.3 Introduction 

3.3.1 What is the Introduction? 

The introduction is largely an optional element. However, if there are any patent rights, the Introduction 
becomes obligatory in order to include the patent declaration. Further guidance on this can be found on the 
CEN BOSS, or by contacting your CCMC contact point. The template contains the text that needs to be 
included in the Introduction if patent rights have been identified, but if there are no patent rights then the text 
after the Note to drafter shall be deleted prior to submission. 

The introduction shall not contain any requirements. 

3.3.2 Styling the Introduction 

The introduction shall be styled as follows:  

• Title: 'Intro Title' 

• Text: Body Text 

4 Main Body – Obligatory Clauses 

4.1 Clause 1 - Scope 

The scope is always Clause 1 of your document, whether it's a regular EN, a Technical Specification (TS) or 
a Technical Report (TR).  

The scope only contains statements of facts. No requirements, recommendations or permissions are allowed. 
The CEN Editor will systematically remove these, and redraft accordingly.  

Styling for Clause 1:  

• Title: Heading 1 

• Text of the Scope: Body Text  

4.2 Clause 2 – Normative References 

The normative references clause is always Clause 2, even if it is empty. 

The correct and up-to-date introductory wording is given in the Standard Template, including the correct 
wording for if this clause is empty.  

Clause 2 references are normatively referred to in the main body of the text. The list of references should be 
checked thoroughly prior to submission to ensure:  

• Each reference is actually normative (if not, the CENELEC Editor will transfer it to the Bibliography); 

• Each reference is still valid and publicly available; and  
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• Each reference has the correct reference and title.  

For any non-EN/ISO/IEC/ETSI, a TC decision may be necessary to determine that there is no European 
equivalent available. It is up to the TC to assess whether a TC decision is necessary or not.  

Normative references to directives and legislation is not permitted under any circumstance.  

Styling for Clause 2 

• Title: Heading 1 

• Introductory wording: Body Text 

• References: RefNorm 

4.3 Clause 3 – Terms and definitions  

4.3.1 General 

The terms and definitions clause is always Clause 3, even if it is empty.  
The correct and up-to-date introductory wording is given in the Standard Template, including the correct 
wording if the clause is empty.  

Styling for Clause 3:  

• Title: Heading 1 

• Introductory wording: Body text  

• Lists in introductory wording (if applicable): List bullet/List Continue  

• Term number: TermNum 

• Term: Term 

• Definition: Definition  

• Notes to Entry: Note 

• Source: Definition 

4.3.2 Drafting the definitions  

Definitions shall be a single sentence/phrase with no full stop at the end. They shall be able to seamlessly 
replace the term in the text. They shall not contain any requirements, recommendations, or permissions.  

If supplementary information is needed, then a 'Note x to entry' can be used. Notes to entry shall be 
numbered, even if there is only one note given. Notes to entry can contain requirements, recommendations, or 
permissions.  

Did you take the definition from a different text? The source can go between square brackets below the 
definition (and below the note to entry, if applicable). The source is informative and can therefore contain any 
kind of reference. See Example 1.  

EXAMPLE 1 [SOURCE: EN 1234-5:2021] 
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5 Main Body – Generic Clauses 

5.1 Symbols and Abbreviations 

In some cases, you may like to add the explanations of symbols and abbreviations used in your text. There 
are two options to do this:  

• Option 1: add the symbols and abbreviations under Clause 4; or 

• Option 2: split clause 3 into two subheadings, where: 

o 3.1 = Terms and definitions  

o 3.2 = Symbols and abbreviations.  

If you have a large volume of terms and definitions, the first option is preferable, just to keep things clean and 
simple.  

Additionally, it is cleaner to lay out the symbols and abbreviations in a table and hide the table borders.  

Styling for symbols and abbreviations:  

• Title: Heading 1 (or Heading 2, if splitting Clause 3).  

o Not in a table: 

 Each symbol/abbreviation and explanation: Body Text 

o In a table:  

 Each table row: Table Body 

5.2 Generic Clause Styling  

Within each additional clause, there are additional styles to use to help structure and layout your deliverable 
with ease.  

When using subclauses, avoid hanging paragraphs, since these are impossible to refer to in the text. Heading 
1 shall be directly followed with Heading 2 if subclauses are used. In this instance, you may use 'General' or 
'Introduction' as a heading. See Figure 6.  

 

Figure 6  Hanging Paragraphs examples 

In some cases, numbered paragraphs may be used (i.e. in apparatus/reagents clauses). These are great for 
when you'd like to refer to a specific paragraph in a specific clause.  
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Styling for generic clauses:  

• Clause title: Heading 1 

• Subclause Title: Heading 2/Heading 3/Heading 4… up to Heading 9 

• Text: Body Text  

• Numbered paragraphs:  

o x.1 – p2 

o x.1.1 – p3 

o x.1.1.1 – p4 

6 Additional components of the text 

6.1  Tables  

Tables are used to lay out information in a clear and concise way.  

Tables shall be simply drafted. If you need to merge cells, do so at the very end of drafting, otherwise cells 
can become corrupted, which can lead to tricky errors when the CEN Editor creates the XML version of the 
text.  

Tables shall have at least the following components:  

• Clear number designation (e.g. Table 1), with an optional concise title  

• A clearly defined header (making the header bold is an easy way to do this) 

• Simply-drafted content.  

Tables may also include:  

• Footnotes  

• Notes  

• Figures/formulae in cells  

• Dimensions (always right-justified) 

Tables can break across multiple pages. If this is the case, simply repeat the header row. To do this, highlight 
the header row(s) and choose the layout tab from the top ribbon in Word. Then, click 'Repeat Header Rows', 
and this will repeat the row selected across the top of each page. 

Do not use nested tables, i.e. a table within a cell. These are systematically removed by the editor, as XML 
does not support them. This can however be time-consuming and create errors, so please don't do it!  

Additional things to avoid when drafting tables:  

• White text on black backgrounds (XML does not support white text) 

• Coloured text on coloured backgrounds 

• Vertical text  
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Example of a perfect table:  

Table 1  A perfectly drafted table  
Dimensions in millimetres 

 Table header 
Additional header info 

Clearly-defined 

Table content  Table content with footnotea - 

Table content  - - 
a A footnote to the table. The callout above is superscript OR raised. The callout in this cell 
is also superscript OR raised.  

NOTE This is a table note. It follows the same rules as a regular main body note.  

 

Styling for tables:  

• Title: Table title  

• Dimensions: Dimension_100 

• Header (all header rows): Table header  

• Table content: Table Body  

• Footnotes: Table Footer  

• NOTES to tables: Table Footer Note 

In some cases, you may need to reduce the font size of the text in your table. In such cases, use:  

• Header: Table header (-) for 10pt; Table header (--) for 9pt 

• Table content: Table Body (-) for 10pt; Table Body (--) for 9pt 

6.2 Figures 

Figures are used to display information more concisely, in the form of a diagram, for example.  

Figures shall be language-neutral; this means no text can be contained therein. There are some exceptions to 
this rule. See the CENELEC BOSS Drafting guidance page for detailed information and technical 
requirements.  
NOTE Figure files are not required for submission, but providing the figure files improves the quality of the deliverable 
immensely.  

Figures shall contain at least a figure image and a figure number designation (e.g. Figure 1, Figure 2, Figure 
A.1, Figure B.2), and preferably an optional title. Figures may also contain:  

• Dimensions  

• Notes 

• Text 

• Key and explanations  

• Subfigures and a letter designation (e.g. a), b), c)).  
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Figures shall be laid out as follows:  

 
Key 

1 key content (hide the borders) 

2 key content (hide the borders) 

NOTE  Figure note content 

Figure text content 

Figure X  Title of figure 

For subfigures, the principle is the same, except that subfigure titles are styled 'Figure Subtitle' instead. The 
subfigure designation shall be simply 'a), b), c)', with an optional title.  

For all subfigures in the same figure, only one key shall be provided. See the example below, which shows 
how to lay this out.  
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a) 

 

b) 
Key 

1 key content (hide the borders) 

2 key content (hide the borders) 

NOTE  Figure note content 

Figure text content 

Figure X  Title of figure 

 
Styling for figures:  

• Figure/subfigure: Figure Image 

• Dimensions: Dimension_100 

• Notes to figures: Figure Note 
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• Supplementary figure text: Figure Text 

• Key title: Key title  

• Key content: Key text (and laid out in a table with borders hidden) 

• Title (and subfigure title): Figure title 

6.3 Formulae 

Formulae are a simple way to display any calculations that are indispensable for the use of the document.  

CENELEC Editors strongly recommend the use of MathType (a paid software add-in for Word), especially if 
you have a huge number of formulae across a large number of standards. However, if MathType isn't 
available, Word has useful tools to help.  

If you have a simple formula, it is better to use the keyboard to type it out as plain text. Symbols like +, - and = 
are generic characters and fully supported by XML. Additional symbols, for example any Greek or 
mathematical symbols, can be found using the 'Symbol' function in Word (the same place you go to for the Em 
dash).  

For more complex formulae, however, you may use the Equation Builder in Word. In the 'Insert' tab across the 
top ribbon, there is the option beside 'Symbol', called 'Equation'. Click this, and it'll insert a blank formula. 
From there, simply type in the information you need! See Figure 7.  

For the layout, please only rely on the style given at the end of this subclause to lay the formula out properly, 
especially if you choose to number the formula. Do not lay the formula out using a table. These have to be 
manually removed by the CENELEC Editor, which is time-consuming.  

When numbering a formula, type out your formula with the desired method, and then insert a tab using the 
keyboard. Then, write your number between parentheses. Once you apply the style, the number will jump 
across to the right side of the screen, leaving your formula on the left.  
NOTE If the styling does not work as described, please leave it as it is and your CENELEC Editor will correct it.  

 

 

Figure 7  Using the Equation Builder 

Styling for formulae:  

• Formula: Formula 

• ‘Where’: Body Text 

• Explanations: Table body (lay out in a table, hide the borders). 

 

6.4 Annexes 

Annexes are found after the main body of the text. They follow the same rules as the main body of the text, 
but the styling of the heading elements is a little different.  

There are two types of Annex:  
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 General Annex:  

 Informative or normative 

 Letter designation (Annex A, Annex B…) 

 Annexes for harmonized deliverables 

 Annex ZZ 

The Simple Template contains the generic Annex ZZ, but additional templates specific to certain legislation 
can be found on the CENELEC BOSS, and pasted directly into the Simple Template. Annex ZZ templates can 
be found at https://boss.cenelec.eu/reference-material/formstemplates/pages/  

Styling for general annexes:  

• Main Annex title: ANNEX 

• Annex clause headings: a2, a3, a4 
NOTE Annex clause headings start from heading 2 because of the letter at the beginning (e.g. A.1, B.2).  

 

https://boss.cenelec.eu/reference-material/formstemplates/pages/


CENELEC Standard Template — Quick Start Guide 

19 

 

Styling for Annex ZZ:  

• Main Annex title: ANNEX Z 

• Annex clause headings: zza2, zza3 

• 'WARNING': Notice 

 

6.5 Bibliography  

The bibliography is the final element of the text and is informative. It contains all the references that aren't 
mentioned normatively in the text, alongside anything else you want the user of the deliverable to access, too.  

Bibliographic entries can be either numbered or un-numbered. Numbering is useful if you want to refer to a 
reference in the text. To number a bibliographic reference, use square brackets, and a tab:  

[1] tab EN XXXX-X, Title 

In some cases, you may want to organise your bibliography under some headings. As regular headings (as 
described elsewhere in this document) are not permitted, the 'biblio description' style is available. Simply type 
the heading you'd like, and then style it as usual. If preferred, this style can be made bold to better define the 
heading.  

Styling for Bibliography:  

• Title: Biblio Title 

• References: Biblio Entry 

• Descriptions/Headings: Biblio Description 

6.6 Code  

Where lines of code are needed, these can be drafted normally as plain text. The code style uses the 'Courier 
New' font, which is acceptable and supported by XML. If you don't want your code to be in Courier New, you 
can simply style it as 'Code' and then highlight the text and change the font back.  

Styling for Code:  

• Code lines: Code  

• Font: Courier New 

7 Finishing touches 

7.1 Introduction 

Once you've finished drafting the text, there are a few key things to handle before creating a final clean PDF 
file, and submitting the text package to CCMC. Headers and footers are a required element of the text, so do 
ensure they're both present.  

7.2 Headers and footers 

7.2.1 Headers 

In the headers, you need to add the reference of the text (if you have it), the year of the text, and the 
language. It shall be laid out as follows:  

prEN XXXX:YYYY (E) 
For Enquiry drafts, the reference always starts with 'prEN'.  

For Formal Votes, the reference always starts with 'FprEN'.  
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Technical Specifications and Reports are always 'FprCEN/TS' and 'FprCEN/TR', respectively.  

The year is always the year in which the text will be launched to the ballot – NOT the year it is submitted.  

The language is 'E' for English, 'F' for French and 'D' for German.  

For new work, it is possible (and probable) that you won't have a reference for the text yet, in which case it 
can be left as prEN XXXX. The CENELEC Editor will add the reference in when they edit the text.  

7.2.2 Footers 

Footers always contain the page numbers. They shall be left or right-justified, depending on the page number 
(see clause 7.2.3). Only the number itself is necessary; there is no need to add 'page' or anything else.  

7.2.3 Justification of headers and footers 

Even-numbered pages shall be left-justified. Odd-numbered pages shall be right-justified. Ensure that the 
justification is continuous after any page-breaks or page-orientation changes.  

7.3 Table of Contents 

Do you use the table of contents as an overview of the document while drafting? Do you regularly meet 
problems with it corrupting, or not updating? An easier way to see an overview of your text is to use the 
Navigation bar on the left-hand side of the screen. The Navigation bar allows you to see all the headings 
(including tables and figures) that are present in the document – you can even hide entire clauses/subclauses 
by using the small arrow at the side.  

To create the Table of Contents from scratch:  
Once you've finished drafting, however, the table of contents will need to be updated. It is also an obligatory 
element, coming before the European Foreword and after the Title Page.  

The Table of Contents shall start with the word 'Contents' justified to the left, and 'Page' in smaller font to the 
right. As a rule, 'Contents' is font size 14 and bold, and 'Page' is font size 10 and not bold.  

 
a) 

 
b) 

Figure 10  Table of Contents header 
Add a hard return after the word 'Page'. Go to the ribbon across the top of Word, and choose the 'References' 
tab  'Table of Contents'  'Custom Table of Contents'. 
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Figure 11 

Click this, and a dialogue box will appear. Click 'Options'.  
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Figure 12 

You will then be presented with a list of elements to be included in the Table of Contents. Pay attention to the 
number of subclauses you have; a large number of subclauses will create a longer Table of Contents, which 
can needlessly increase the overall page count of the document.  

As a rule, the following elements should be included in the Table of Contents:  

 ANNEX (and ANNEX ZZ if your text is harmonized) 
 Biblio Title 
 Foreword Title 
 Headings 1, 2 and 3 (or just headings 1/2 if there are a lot of subclauses) 
 Intro Title 

To add these elements, in the dialogue box, click 'Reset'. This will remove any unnecessary elements from the 
list. Then, after each of the headings in the list above, add a number 1 in the corresponding boxes, except for 
Headings 2 and 3, which need a 2 and 3 respectively (see Figure 13).  
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Figure 13 

Once all the elements are added, click 'OK' and then again, and the Table of Contents will appear. From 
there, any modifications you bring to the text can be included simply by right-clicking anywhere on the Table of 
Contents, and clicking 'Update Entire Table'.  

To replace an existing Table of Contents 
Highlight the existing Table of Contents, and then follow the same steps outlined above. The only difference is 
that, when you click OK in the dialogue box shown in Figure 13, you will be asked if you'd like to replace the 
selected Table of Contents. Click 'OK', and the new Table will appear.  

 
Figure 14 

7.4 Creating the PDF 

The final clean PDF file can be generated either using the Adobe Acrobat extension in Word (if you have that 
software installed), or by saving the Word document as a PDF (Save As  PDF file).  
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Annex A 
(informative) 

 
Useful Information Sources 

A.1 General 

In addition to this Quick-Start Guide, CENELEC offers plenty of drafting guidance and help to make sure that 
your deliverable is of the highest-quality. If you're stuck on any of the drafting elements, you can access any of 
the resources outlined in this annex.  

A.2 Webinars  

The CENELEC editors regularly give webinars tailored to drafting. These webinars are usually in-depth on any 
specific drafting element and come with a YouTube recording and a PDF of the presentation, as well as a 
Q&A sheet containing audience questions, and responses from the editors.  

The most up-to-date webinars are from 2020.  

Webinars for Standards Drafters from 2020.  

In addition, there is a dedicated webinar for the Standard Template, including a live demonstration, from 2021.  

Webinar for Standards Drafters – Standard Template Quick Start and Drafting Guidance.  

A.3 Internal Regulations Part 3 

The Internal Regulations Part 3 (IR-3) is the standard for standards. The rules outlined in the IR-3 are closely 
followed by the editors, and are used in every webinar – even in this document, too! It is worth keeping a 
bookmark in your preferred web browser with a direct link to the IR-3, so that you can ensure you have the 
latest rules for drafting at your fingertips. 

See specifically Annex A for a comprehensive checklist of all the elements of a standard to make sure you've 
covered everything necessary.  

Internal Regulations Part 3:2019 

A.4 Still stuck?  

If you still need help, you have some options:  

1. Contact Mail Production  

If you do not have an editor already allocated to a text (for example, you're starting new work or you 
haven't yet submitted anything), then you can contact production@cencenelec.eu and a colleague will 
happily pass on your question to an editor.  

2. Contact your CCMC contact point  

This information is found on ProjexOnline. Usually, it is the editor allocated to your document. 
However, you can also contact the Technical Sectoral PM, and they will be able to guide you to an 
editor for help.  

Editors can also be present at your meetings, too! We can offer live help either in person, should you be 
present in the Management Centre, or via Zoom or Teams. Just ask!  

 

https://experts.cenelec.eu/trainings-materials/events/?datefilter=PERIOD&Types%5B%5D=8553&Categories%5B%5D=8557&past=1&tags%5B%5D=&page=1
https://experts.cenelec.eu/trainings-materials/events/2021/2021-12-02-webinar-simple-template/
https://boss.cenelec.eu/reference-material/refdocs/pages/
mailto:production@cencenelec.eu
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Annex B 
(Informative) 

 
Useful Keyboard Shortcuts 

When drafting your document, lots of mouse-clicking can become quite tedious. Table B.1 contains 
a list of common keyboard shortcuts you might find useful while drafting.  
NOTE Additional keyboard shortcuts within MS Word can be researched online. 

Table B.1  Common keyboard shortcuts 

Keyboard Shortcut What does it do? 
Ctrl+A 
Ctrl+C 
Ctrl+V 

Selects all text in the document 
Copies all selected text to clipboard 
Pastes all text copied to clipboard 

Ctrl+arrow keys Jumps the cursor along entire words 

Ctrl+Shift+arrow keys Highlights entire words/sentences, as well as entire table cells/rows 

Ctrl+Shift+C 
Ctrl+Shift+V 

Copies style of highlighted paragraph 
Pastes style of highlighted paragraph 

Ctrl+Alt+n Used to enter draft view, to see the styling pane and styles behind 
each paragraph 

Ctrl+Z 
Ctrl+Y 

Used to undo the previous action (typing/styling) 
Used to redo the previous action if it was undone accidentally 

Ctrl+d Opens up the font dialogue box (for advanced font settings – e.g. 
raised/lowered super/subscripts) 

Esc Exit dialogue boxes 

Alt + underlined letters 
e.g. Alt+F 

Completes the action described by the underlined letter 
(e.g. save, cancel…) 

Tab key/arrow keys Can be used to scroll through menus  

Ctrl+Enter Soft return (not recommended for formatting/layout purposes) 

Ctrl+F, search for ^l Finds soft returns in the text (so they can be replaced with hard 
returns) 

Ctrl+F, search for ^p Finds hard returns in the text 
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